© Labcenter Electronics Ltd 1990-2007. All Rights Reserved.

The PROTEUS software programs (ISIS, PROSPICE and ARES) and their associated library files, data files and documentation are copyright © Labcenter Electronics Ltd. All rights reserved. You have bought a licence to use the software on one machine at any one time; you do not own the software. Unauthorized copying, lending, or redistribution of the software or documentation in any manner constitutes breach of copyright. Software piracy is theft.

PROSPICE incorporates source code from Berkeley SPICE3F5 which is copyright © Regents of Berkeley University. Manufacturer’s SPICE models included with the software are copyright of their respective originators.

WARNING

You may make a single copy of the software for backup purposes. However, you are warned that the software contains an encrypted serialization system. Any given copy of the software is therefore traceable to the master disk supplied with your licence.

PROTEUS also contains special code that will prevent more that one copy using a particular licence key on a network at any given time. Therefore, you must purchase a licence key for each copy that you want to run simultaneously.

DISCLAIMER

No warranties of any kind are made with respect to the contents of this software package, nor its fitness for any particular purpose. Neither Labcenter Electronics Ltd nor any of its employees or sub-contractors shall be liable for errors in the software, component libraries, simulator models or documentation, or for any direct, indirect or consequential damages or financial losses arising from the use of the package.

Users are particularly reminded that successful simulation of a design with the PROSPICE simulator does not prove conclusively that it will work when manufactured. It is always best to make a one off prototype before having large numbers of boards produced.

Manufacturers’ SPICE models included with PROSPICE are supplied on an ‘as-is’ basis and neither Labcenter nor their originators make any warranty whatsoever as to their accuracy or functionality.
INTRODUCTION

The purpose of this getting started guide is to familiarize you as quickly as possible with the main features of ARES to the point that you can use the package for real work. Users with modest computer literacy should find it possible to learn the package and produce their first board within a day or two.

It is extremely important to realise that this is not intended to be a comprehensive resource. The online manual, accessed from the Help Menu in ARES, is a full reference manual and contains far more detailed discussion on all of the topics covered in this guide. It follows that this should be the first port of call should you need clarification of techniques or functionality.

The tutorial proceeds by taking you through worked examples involving all the important aspects of the package including:

- Basic techniques for placement and routing.
- 3D Board Visualisation.
- Netlist based design including both manual and automatic routing.
- More advanced editing techniques such as block editing and route editing.
- Hard copy generation.
- Library part creation.

We do urge you to work right the way through the tutorial exercises as many things are pointed out that if missed will result in much wasted time in the long run. Also, having worked through the tutorial and thus got a basic grasp of the concepts behind the package you will find it much easier to absorb the material presented in the reference chapters.

Note that throughout this tutorial (and the documentation as a whole) reference is made to keyboard shortcuts as a method of executing specific commands. The shortcuts specified are the default or system keyboard accelerators as provided when the software is shipped to you. Please be aware that if you have configured your own keyboard accelerators the shortcuts mentioned may not be valid.
OVERVIEW OF THE LAYOUT EDITOR

We shall assume at this point that you have installed the package, and that the current directory is some convenient work area on your hard disk.

To start the ARES program, click on the Start button and select Programs, Proteus 7 Professional and then the ARES 7 Professional option. The ARES Layout editor will then load and run. Along the top of the screen is the Menu Bar.

The largest area of the screen is called the Editing Window, and it acts as a window on the drawing - this is where you will place and track the board. The smaller area at the top left of the screen is called the Overview Window. In normal use the Overview Window displays, as its name suggests, an overview of the entire drawing - the blue box shows the edge of the current sheet and the green box the area of the sheet currently displayed in the Editing Window. However, when a new object is selected from the Object Selector the Overview Window is used to preview the selected object - this is discussed later.

The control bar at the bottom of the application is worthy of further mention and essentially splits into four sections: At the left hand side is the Selection Filter which allows you to configure both the layers and the objects that will be selected in the current operating mode. Typically, the default rules will suffice and this serves simply as a convenient override where you may wish finer granularity in selection at a given time. The Layer Selector combo box also determines the current layer or layer set and also applies to the placement of PCB objects.

In the middle is the Status Bar which provides textual ‘hints’ on the object currently under the mouse. This is particularly useful when you hover a mouse over a pad for example, as it will inform you which net the pad is on.

Towards the right hand side is the live Design Rule Checker. This will report any physical design rule violations that occur while the board is being designed. A left click on this will launch a dialogue detailing the violations with the further option of zooming in to examine a particular error.
At the far right hand side is the co-ordinate display which reads out the position of the cursor when appropriate. These reflect not the exact position of the pointer but the location to which it has been snapped. Default snapping options are selectable from the View menu (or via keys CTRL-F1 and F2 - F4) and the snap values can be configured from the Set Grids command on the System menu.

Co-ordinates can be in imperial or metric units as set by the Metric (default key mapping 'M') command. You can also set a false origin using the Origin command (default key mapping 'O') in which case the co-ordinates change colour from black to magenta.

The dot grid on the Editing Window can be toggled on and off using the Grid command, or via its keyboard shortcut (by default this is ‘G’). The spacing of the dots normally reflects the current snap setting, except when zoomed out. In this case, the dot spacing is set to a suitable multiple of the snap spacing.

ARES can be set to display an X cursor at the position to which it has snapped the pointer through the X-Cursor command, default key mapping is ‘X’.

Having now completed a flying tour of the layout editor we’ll cover the above in practical usage over the subsequent sections of the tutorial.

BASIC PLACEMENT & ROUTING TECHNIQUES

Overview

Before going on to look at designing a board from a netlist we shall first cover the basics of placing and routing using the extremely simple board shown below. It is worth taking a moment before we begin to explain how ARES attempts to help you understand what is happening during board layout. There are two principle techniques:

ARES will ‘twitch’ an object when that object is under the mouse and the selection filter enables selection of that object type. This serves to identify when an object is ‘hot’.

ARES provides dynamic cursors which change to identify what a left click will do at any given time (place an object, select an object, move an object, etc.). A list of cursor types is shown overleaf:
Standard Cursor.

Placement Cursor – left click will place an object according to mode.

Selection Cursor – a left click will select the object under the mouse.

Movement Cursor – a left drag will move the object(s) selected.

Throughout this tutorial – and indeed whenever you are working in ARES – you should make use of these visual indicators to as an aid to understanding the software.

**Package Selection**

The most direct way to build up a rough layout of a board is to drive ARES in Package mode. In this mode, you can pick component footprints or *Packages* directly from the library and place them onto the work area.

⚠️ *This mode of operation is not recommended for anything but the most trivial of boards. Netlisted designs from the capture package (ISIS) enables additional functionality (verifiable connection routing, configuration of strategies, full power plane support, etc) and is the recommend mode of operation. This is discussed later in the tutorial and throughout the reference manual.*

In our simple example, three packages are used:

- CAP20
- DIL08
- RES40

and you can start by picking them from the package library. To do this, first click left on the *Package Icon*. Next, click left on the "P" toggle at the top left of the *Object Selector*. The *Library Pick* form will appear as shown.

![Library Pick form ready for selection.](image)

ℹ️ You can also select the *Library Browser* via it’s keyboard shortcut. By default this is mapped to the ‘P’ button but you can map it to another keyboard shortcut via the *Set Keyboard Mappings* command on the *System* menu.

The *Library* Browser is a very powerful tool and you can search for a given library part in a number of different ways. Probably the simplest (and perhaps the most powerful) method is simply to type in some keywords that describe the part you are looking for. This works in much the same fashion as the Google™ Internet search engine,
matching your search terms against the descriptions of the packages in our libraries. Try this now with the capacitor, entering the search term '200th pitch radial capacitor' in the Keywords field. You should see that the CAP20 part is now listed in the results list as shown overleaf.

![Library Pick form with the keywords as above and the CAP20 in the results list.](image1)

You can customise what is shown in the results list by right clicking on the results and configuring which fields you want to view.

Double click the mouse on the CAP20 part to select it into the Object Selector as in the screenshot below.

![Object Selector with the CAP20 listed.](image2)

If you know the name of the part you want to find you can also use the Keywords editbox to search by name. In our example above, typing CAP20 in the keywords list would also yield the desired result.

You could, of course, repeat the process above for the remaining two packages in our simple layout but instead we will look at other methods of selection. Underneath the Keywords textbox on the left hand side of the dialogue form are a number of filters which can be used independently of the keyword entry. These are particularly useful for browsing the libraries where you are not entirely sure which keywords would be best suited for the part you want. Try this now with the DIL08 part by clearing the text from the keywords textbox and selecting the Integrated Circuits Category, the Through Hole type and the Dual Inline Subcategory. Again, double clicking on the DIL08 in the results list will select the part into the layout.
Finally, we will use a combination of the above methods to find and pick the **RES40**. Select *Discrete Components* as your category and type **RES40** in the keywords list. In this situation the keyword search takes place only on those parts in the subset of the libraries filtered via the category and type fields. Select the part into the layout in the normal way and close the dialogue form.

**Package Placement**

The three package names should now have appeared in the *Object Selector* as shown below, with the last one you picked highlighted.

![Object Selector with the requisite packages selected.](image)

We will start by placing the **DIL08** on the layout. Ensure that this part is selected by left clicking on it in the *Object Selector*. A preview of the part will be shown in the *Overview Window* at its current orientation. You can use the *rotation* icons (shown below) to rotate the part into the desired orientation prior to placing – the *Overview Window* will update to show the specified rotation.

![The rotation icons in ARES](image)

To place the part point somewhere in the middle of the *Editing Window* and left click the mouse. A green outline of an 8 pin IC will appear which will follow the mouse as you move it around the *Editing Window*. Position it roughly central and left click the left mouse button to commit the part and exit placement mode.
Positioning the DIL08 in placement mode

When in placement mode a right click of the mouse serves to cancel the current placement operation.

When in placement mode you can also rotate the part dynamically via the ‘+’ and ‘−’ keys on the numerical keypad. As with all commands in ARES these keyboard shortcuts are defaults and configurable to your preference via the Set Keyboard Mapping command on the System menu.

Now select the RES40 package and place the two resistors, 0.1" apart (2 grid squares) and just above pin 8 of the IC. Similarly, place the capacitor outline just below pin 1.

Unless you are quite adept, you may not have the components positioned quite correctly, so we will now take a look at how to select and move things around.

Selecting and Moving Packages

Start by moving the mouse over the outline of a footprint. Depending on where the mouse is, either the pad or the footprint itself will be encircled by a thin white line (object twitching). Additionally the mouse cursor will change to be a hand with a pointed finger (dynamic change to selection cursor).

Given both these indicators a left click will select the footprint entirely (clicking on an owned part of a footprint will select the footprint). If you do this now you should see the footprint itself being tagged and the mouse cursor has now changed to indicate that the footprint can be moved.

By depressing the left mouse button and dragging the part you can then reposition as required, releasing the mouse at the desired location. A left click in a free area of the board will then deselect the footprint entirely.

Alternatively, when you have the outline and cursor as above you can right click the mouse. This will both select the footprint and provide you with a context menu of actions that can be performed on the footprint. Obviously in the current context, the action would be Drag Object.
Routing

Routing mode is commenced by clicking left on the Trace Icon. The Object Selector will change to display a list of 'Trace Styles' - the default selection of track widths. Select T20 for a 20 thou track.

Other points to note about routing mode:

- Clicking twice at the same point places a via and changes the current layer as defined by the Set Layer Pairs command on the System menu. The selection of via types can be displayed by clicking on the Via Icon.
- Whilst routing, you can change the current layer by pressing the PGUP and PGDN keys. In addition CTRL-PGUP selects the top layer and CTRL-PGDN selects the bottom layer.
- Holding the CTRL key down allows you to place a curved track segment. The progress of the arc (horizontal then vertical or vice versa) is determined by how you move the mouse away from the fixed point. It is best to press and hold the CTRL key, then move the mouse, then click left, then release the CTRL key.

Annotation

When components are placed in Package mode, they have no annotation information associated with them - later on you will see how components are automatically annotated when a netlist is used.

To annotate the components, first leave trace mode, for example by selecting Selection Mode, and then click left twice on a component (the first click will select and the subsequent left click will present the edit package dialogue form).

Alternatively, enter selection mode and then right click on the package, selecting Edit Properties from the resulting context menu.
Editing a package's properties from the right mouse context menu.

Each time you do this, a form will appear with fields for the part ID and value.

The Edit Component Dialogue form with an example Part ID and Value entered for a resistor

Alternatively, the Auto Name Generator command may be used to generate numerical sequences for component numbering.

Part IDs and values can be moved by tagging the parent object and then pointing specifically at the ID or value before dragging using the left mouse button. Bear in mind also that you can set different snapping grids from the Display menu or by using the mapped keys (by default these are CTRL-F1 and F2-F4 – keyboard commands can be configured via the Set Keyboard Mapping command on the System menu).

The default size for these labels can be determined using the Set Template command on the System menu.

Board Outline

ARES has a special layer, the EDGE layer, which is intended for holding 2D graphics which represent the board outline. Objects placed on the EDGE layer will appear on artwork generated for any of the other layers.

In this case, the board outline is just a box.

To place a rectangular board edge:

1. Select the Box Icon.
2. Select the EDGE layer from the Layer Selector.
3. Point at where you want the top left corner of the box and left click the mouse.
4. Drag out the box to encompass the board and left click again to place the graphic.
5. If you need to resize the box, tag it by pointing at it and clicking right (ignoring the resultant context menu), and then drag the green sizing handles as required using the left mouse button.
Placing a rectangular board edge on the layout.

Curved or irregularly shaped boards are fully supported; the boundary should be formed from lines and arcs, or by selecting the Path Icon and drawing a single path object.

When you have finished experimenting with this exercise, save it if you wish and then start a new layout for the next exercise by using the New Layout command on the file menu.

**BLOCK EDITING FACILITIES**

We have seen already that an object can tagged by pointing at it and clicking left (using cursors and object ‘twitching’ as visual indicators), or by clicking right (with an associated context menu). Once tagged it can be dragged (left button) or deleted (right button). There are, however, another couple of ways to tag objects. If you point at no object, hold down the right button and drag the mouse, a bounding rectangular box will appear. When you release the button, any objects inside the box will be tagged. Load 'PPSU.LYT' from the Samples directory of your Proteus Installation (located in the Tutorials subdirectory) and then give this a try by dragging a tag box round the entire layout.

*Refining Selection with the Selection Filter*

Once the entire board is selected you can refine the currently tagged object set using the selection filter. As the name suggests this controls what objects are selected in a given mode. For example, we could deselect all the footprints and select all the ratsnest connections by turning off the component selection icon and turning on the ratsnest selection icon.

*Default Selection Filter*  
*Ratsnest On and Packages Off.*

The selection icon on the far left controls which layers are enabled for selection. Toggling this switches between all layers (the default) and current layer only. You can see this by switching into Package Icon and then tagging the entire board as described previously. Note that if you toggle the layer selection icon then only objects on the component side will be tagged – notably in this case the board edge is deselected.
Default Selection Filter in Package Mode

The combination of being able to control which objects and which layers are available for selection is extremely powerful. The selection filter does have preset defaults according to which mode you are in (track mode, package mode, pad mode etc) but you can easily and quickly customise to the requirements of the current operation by using the filter.

You can even customise the defaults per mode via the Set Selection Filter on the System menu if you prefer a specific selection set that isn’t available. We do not recommend this until you are comfortable and familiar with how the system is designed to work.

Refining Selection with Drag Handles

You can also refine the currently tagged object set by resizing the tagbox itself. Drag handles appear on the tagbox as small green boxes and you can drag them simply by positioning the mouse over the handle, depressing the left mouse button and moving to the desired position.

Dragging a tagbox to limit the selected objects.

Additional control is provided by the trace bounds selection icon on the selection filter. When toggled this switches between ‘fully enclosed’ (tracks must be entirely bounded by the tagbox to be selected) and ‘partially enclosed’ (tracks that are partially bounded by the tagbox will also be selected) modes.
Object selection, and in particular the selection filter, is an area that is extremely difficult to describe and extremely
easy to use effectively. The following rules however, provide simple guidelines:

- When selecting individual objects look for the visual indicators. The object twitch will tell you which object the
  mouse is over (the object) and the cursor will tell you what will happen when you left click the mouse (the
  action).

- If you are not getting both the pointed hand mouse cursor and the object ‘twitch’ as you move the mouse
  over the object either change modes or use the selection filter to refine the layers/objects available for
  selection.

Having now covered selection basics, lets look more closely at block operations. Start by drawing a tag box on the
PPSU layout. Note that when the mouse is then placed inside the tag box the cursor changes to the ‘movement’
cursor (orthogonal cross arrows). Depressing the left mouse button and dragging at this point will allow you to block
move everything inside the tag box. Better still, you specify the ‘pick up point’ according to the point inside the box
where you left depress the mouse.

All the block operations are also available via the right hand context menu. Again, the pick up point for move, copy
and rotate operations is the point inside the box where you perform the right click operation.
Experiment with these operations now, controlling selection via the selection filter and tagbox techniques and performing various block operations as detailed above. You can undo your changes via the *Undo* command on the *Edit* menu or via the keyboard shortcut **CTRL+Z**.

You might also try completing a few routes and then experimenting with tagging just one or two components and moving them – remember that if you use a tagbox for selection you can control whether the traces are included or not by using the *trace bounds* selection icon.

| To place traces you must first select the *Trace Icon* and then select the desired trace style from the *Object Selector*. |

**ROUTE EDITING**

**Overview**

Powerful route editing facilities are a major feature of ARES and we shall now take a good look at the features available in ARES.

Unlike many other PCB design packages, route editing in ARES is based around the topology of the current tracking rather than depending in any way on how the sections of track were laid down. In addition, modifications can be made to any part of a route, not just to sections between 'nodes'.

You may wish to reload the **PPSU.LYT** board from disk before continuing.

**The Context Menu**

If you click right on a track, the track will be highlighted and a popup menu will appear with options to:

- Delete, Copy and Move the route.
- Change the layer and trace style.
- Change the via style.
- Control the Mitring for the route.
- Trim the selection as required for further operations.

The *Copy* command provides the means to do memory buses and similar repeated patterns of tracking. You can make as many copies as are required by repeatedly clicking left. Click right to finish.

The Full Context Menu for a tagged track.
Via Placement

In almost all circumstances, vias are placed automatically for you. To see this in operation select the Trace Icon and place a route segment by clicking left at two points. Now click left over the second point a second time, then at a third point and finally click right to terminate the route.

Clicking (left) at the same point twice causes ARES to place a via and change the current layer so that (in this case) the next segment will be placed on the top copper layer. At the same time, a via is placed at the point where the route changes layer.

Which layer is selected is determined by the Set Layer Pairs command on the System menu. It is possible to define layer pairs, triples or whatever as required. You can also change layer manually whilst placing a route by using the PGDN and PGUP keys, but note that a via is not placed in this case.

The type of via used can be changed by selecting the Via Icon and choosing one of the via styles from the Object Selector. You can also place, replace, tag, move and delete vias manually in this mode. The left and right mouse buttons operate as for manipulating components.

For multi-layer boards, you can select whether normal, blind or buried vias are placed by selecting the Via Icon and then adjusting the Layer Selector.

Tagging a Route

To re-route, delete, edit or copy a section of tracking requires that you first tag it. In a similar fashion to the object editing facilities, you can do this by clicking right on it which will both tag the route and present you with a context menu with a listing of actions that can be performed on the route. There are however additional refinements for traces allowing you to select partial areas of a given route.

Right clicking on the track will select the entire trace and produce a context menu with four option for refining the selection.

Selection Refinement Options on the Context Menu for a Trace.

The first three options are fairly self-explanatory but the last option, ‘Trim Manually’ may need some explanation. Selecting this will first of all anchor one end of a manual selection at the point on the track at which you clicked the mouse. A green arrow will follow the mouse allowing you to specify the other endpoint for the selection – clicking the left mouse elsewhere on the trace will select the area of track between the two endpoints.

Manually selecting a portion of a track.

As with object editing, pointing at nothing and clicking left untags the tagged route.

We suggest that you practice tagging and untagging the routes on the layout before proceeding further - it is important, though not at all difficult, to grasp how this feature works.
Moving/Dragging a Tagged Route

Once you have a section of tracking highlighted, you can drag any of its segments by pointing and dragging with the left mouse button. You should route editing in ARES very intuitive and easy to follow but a detailed explanation is provided in the reference manual.

You can do a quick ‘tag and drag’ by right clicking the mouse over the trace and selecting the ‘Drag Routes’ option from the resulting context menu. This works provided that you want to action on the current route segment – otherwise you must first define the section of route to be actioned on via the ‘trim’ context menu options as detailed above.

Deleting a Tagged Route

There are two ways to delete tracking.

- The Block Delete Icon will delete all highlight objects on the layout. During route editing, these are typically just the tracks that you have tagged, so this works as a quick way to delete the tagged route.
- You can also delete a single, interconnected section of tracking using the Context Menu by right clicking and selecting the Delete Route option.

Changing a Route’s Width

If you need to change the width of a section of tracking, you must first select the section of track for the operation and then change the style of the selected section.

Right click on the track, configure the selection as detailed above and then simply right click and select the Change Trace Style option, choosing an option from the available styles.

You can of course create your own trace styles if required from the New Trace Style command on the Edit menu. This is discussed in more detail later in the documentation.

Remember that to change track widths globally, you can always edit the appropriate trace style by selecting it and clicking on the Object Selector ’E’ toggle. Note that this will be a global change across the layout, affecting all tracks of the style edited.
Auto Track Necking

In many cases, the reason for necking down a track is to make it can pass between two pads or other obstacles without violating the design rules. The Auto Track Neeking feature allows ARES to do this for you.

The function is controlled by the Set Default Rules command on the System menu. The dialogue form allows you to enter the clearances for pad-pad, pad-trace and trace-trace and also the trace style to neck to. The default neck style is T10 - a 10 thou trace.

Re-routing

Finally, there is a very nice way of modifying the actual path taken by a route. Once you have a tagged route, you can alter its path by simply placing a new section of tracking (in the usual way) that starts and ends on the old one. You can then easily removes the old section to complete the rerouting operation. This is a very natural way to work - all of the route editing operations shown in the diagram below can easily be carried out with this feature.

Note that vias which are made redundant (i.e. secondary vias) will also be removed, along with the shorted out section.

You will find this feature especially useful for moving routes that turn out to be blocking other ones towards the end of the routing process.

Connectivity Highlight

Although not strictly part of the route editing facilities, Connectivity Highlight does come in most handy at the end of the routing process when you find yourself needing to check which connections have and (more importantly) have not been made. For example, you might want to know if a clock signal has been connected to all the chips requiring it.

To see the feature in operation, select the Connectivity Highlight Icon. Click left on a component pad with attached tracking and you will see that everything connected to that pad will be highlighted in bright white. All such highlighted objects will remain highlighted, irrespective of pan and zoom operations, until you invoke the Redraw command (default Keyboard Configuration 'R').

Connectivity Highlights via Pad Selection

Also in this mode, clicking on the net selector toggle will highlight all objects assigned/connected to the currently selected net.
Clicking on the *Delete Icon* will delete traces or vias highlighted by either of the above techniques thus providing the means to delete all or part of a net.

**3D VISUALISATION**

Assuming that the board is now routed and ready for production we first want to examine it in 3D in order that we can properly preview how it will look in real life and possibly make final design alterations prior to prototyping. Start by invoking the 3D Visualisation Engine from the *Output* menu in ARES.

The initial 3D View of our PPSU Layout.

**Basic Navigation**

The first thing we can do is view the board from different preset angles. Five preset views are supplied: top view, front view, back view, left view and right view and these are accessible via any of the following methods:

- Menu options on the *View* menu in the 3D Viewer
- From the navigation toolbar at the bottom of the 3D Viewer
- From keyboard shortcuts **F8** through **F12** whilst in the 3D Viewer.

The 3D Navigation Toolbar.
Now that we can look at the board from a number of angles the next thing is to be able to look at it at a specific zoom level. Again, there are numerous ways to zoom in and out of the board:

- Roll the middle mouse wheel in and out (recommended)
- Menu options on the View menu
- From the icons on the Navigation Menu
- From keyboard shortcuts $F6$ (zoom in) and $F7$ (zoom out)

Experiment now with custom zoom levels and different preset views – whilst it is pretty subjective we envisage most users changing views via the navigation toolbar or keyboard shortcuts and using the middle mouse wheel to zoom in and out.

**Custom Views**

The next logical step is to be able to customise the view. This works conceptually by ‘attaching’ the mouse to the camera such that as you move the mouse the camera moves to the area of the board that you are interested in. You can invoke the Navigation mode either from the View menu, the crosshairs icon on the Navigation toolbar or simply by clicking the left mouse button.

![The mouse cursor when navigation mode is invoked.](image)

You will know as soon as you are in Navigation mode as a crosshair cursor will appear over the mouse and your view of the board will change as you move the mouse. Using this together with the middle mouse wheel zoom will allow you to both ‘fly pass’ the board and to easily zoom in to closely examine a particular area of the board. Exiting navigation mode is as simple as right clicking the mouse.

For example, if we start in Front View (use the $F9$ keyboard shortcut) and we want to examine the resistors on the right we might proceed as follows:

1) Left click the mouse to enter navigation mode.
2) Move the mouse over the resistors.
3) Roll the middle mouse button to zoom in as required.
4) Right click the mouse to exit navigation mode.

The final necessary piece to completely customise the view is to allow users to spin or ‘orbit’ the board. This is done in navigation mode by holding down the left mouse button and moving the mouse. Essentially this will spin the board as you move the mouse – when you release the mouse button the camera will follow the mouse around the current view of the board as normal. Try this now, experimenting with different views of components on the board.

Remember that, if you are struggling to get the view you want you can use the keyboard shortcuts or navigation toolbar to return to one of the preset views. You should find however, that with only a little practise you become quite proficient at navigation.

To summarise:

- Left click enters navigation mode.
- Camera follows mouse around the board in navigation mode.
- Using the middle mouse wheel (or shortcut keys) allows you to zoom as you move the camera.
- Left depressing the mouse in navigation mode allows you to spin/orbit the entire board.
- Right click of the mouse exits navigation mode.

When you are finished close the 3D Viewer from the File Menu to return to ARES.
More information on 3D Visualisation including model creation, customisations and applying 3D data to legacy designs can be found in the 3D Viewer section in the online reference manual (Help Menu in ARES – Help Index command).

HARD COPY GENERATION

Last, but by no means least, we come to the crucial business of reproducing the pretty on-screen graphics on paper or film. Under Windows, most hard copy devices are supported through the normal Windows printer drivers. Additionally, we supply our own drivers for pen-plotters, Gerber photoplotters and Excellon NC drill machines.

We will deal here solely with printing to an ordinary Windows printer device - it is unlikely that you will have a photoplotter to hand! The first step is to select the correct device to print to using the Printer Setup command on the Output menu. This activates the Windows common dialogue for printer device selection and configuration. The details are thus dependent on your particular version of Windows and your printer driver - consult Windows and printer driver documentation for details.

Then, with a layout loaded, invoke the Print command from the Output menu. The dialogue forms offer a number of controls, all of which have context sensitive help associated with them (context sensitive help on dialogue forms is accessed with a ‘point and shoot’ mechanism via the ‘?’ key at the top right of the dialogue form). The default settings should do for getting something and you commence output generation by clicking on OK. Output can be aborted by pressing ESC, although there may be a short delay before everything stops whilst ARES and your printer/plotter empty their buffers.

With plotters in particular, you will probably need to experiment with pens, paper, and the various settings on the Set Devices dialogue form in order to get optimum results. Full details may be found under the chapter Hard Copy Generation in the reference manual.

You may also wish to experiment with compensating for any inaccuracy of scaling in your output device using the layout CALTEST. LYT (in the "Samples\Schematic and PCB Design" directory of your Proteus installation) and the XCompensation/YCompensation fields which are located on the Print dialogue form.

ARES will remember your printer settings from the Printer Setup dialogue and maintain them independently of your printer settings for other applications. This means that you can configure a default set of printer options solely for use with the ARES application.

CADCAM output and Gerber Viewing are described in a separate chapter entitled Cadcam Output in the online reference manual.

LIBRARIES

ARES comes pre-supplied with a large quantity of footprints, and we have seen previously how to select and place these parts on to a layout. However, it may be necessary at times to create your own custom footprints or symbols – also a simple task with ARES – and this process is detailed below.

The Package Library

Packages are made by placing pads, silk screen graphics (and optionally tracks) in the work area, tagging them, and then invoking the Make Package command on the Library menu. The following quick and simple example outlines the basic procedure.

First select the Circular Pad icon and then the C-80-30 style from the Object Selector as shown below.

![Circular Pad Icon](image)

![Object Selector with the C-80-30 Pad style selected.](image)

Place two of these pads 0.5" apart and then select the Box Icon and draw a box around the two pads. Your crude footprint should now look like the following:
Finally tag the whole ensemble by dragging a box round it with the right mouse button and invoke the Make Package command on the Library menu. Enter TESTPKG as the name and create a new category called TESTS. After filling out the rest of the fields as appropriate (see the screenshot below for an example) we can switch to the second tab in the dialogue form to configure 3D Visualisation parameters.

Essentially what we are doing here is providing as much information as possible in order to get a sensible 3D image of the part which can then be used when we use the 3D Viewer to examine a board. This job is greatly aided by a 3D Preview on the dialogue form which will update live as we adjust parameters. Discussion of parameters and values is beyond the scope of this tutorial and is discussed in some depth in the online reference manual (Help Menu in ARES – Help Index). For our purposes, simply fill out the property fields as shown overleaf.

When you are finished click the OK button to commit the changes to the library.

Note that the description you enter via the Make Package dialogue form will be used via the Library Browser when searching via keywords. While not of particular importance in our test case you should give some thought when creating a part to ensure that the description contains keywords that you would use to identify the part during a search.

If you now select the Package Icon, you will see that TESTPKG has appeared in the Object Selector, and can be placed like any of the packages you have used so far. Similarly if you look under the Library Browser (as explained
previously) you should be able to easily find your part via the TESTS category or by typing in the package name. Finally, if you place the part on the layout and invoke the 3D Visualisation engine from the Output Menu you will see the 3D rendered image of the part.

The reference or anchor point for a package is always the first pad placed, unless one was explicitly defined using an ORIGIN marker when the package was created.

There is rather more to it than this - you can, for example, have pads which are on one side only, and silk screen legends on both sides of the board. For further details, see the chapter on Library Facilities within the online reference manual (Help Menu in ARES – Help Index).

To edit an existing package, pick it from the library, place it on the layout, right click on the part and then invoke the Decompose command from the resulting context menu.

Decomposing a package into it’s constituent parts.

This will break the package into its constant elements (pads and 2D graphics). It is not recommended to do this to a component that is part of a layout.

The Symbol Library

Symbols are simply groups of 2D graphics objects which are stored in a library for general use. Typical applications include things like drilling targets, graphics for non-electrical components like brackets and heat-sinks, and possibly your company logo.

You make a symbol by tagging the 2D graphics objects which form it (including, if you like, other symbols), and then invoking the Make Symbol command. Note that layer information is ignored when making a symbol.

A symbol may also be edited using the Decompose command as described for packages.
ROUTING A PCB FROM A NETLIST

In the previous exercise, you used ARES as no more than a computerized drawing board. This is useful for covering basic principles of operation but ARES 7 is really intended to be used in conjunction with ISIS and 99% of developers will (and should!!) work in this way. Since it is much easier to check that a schematic is correct, the overall result is an improvement in the quality of your design process. Also, since ARES can use the netlist to show you what is connected to what, there is no longer the need for constantly referring to databooks in order to check pinouts and so forth.

Preparing a Schematic for PCB Design

For the purposes of this exercise, you need to close ARES without saving any changes (such that the PPSU board is returned to its original state) and load up the sample design PPSU.DSN. You will find it in the "Samples\Tutorials" directory within your Proteus installation.

This design is shown below:

![The PPSU Schematic Design.](image)

The ISIS library parts already contain packaging information for the PCB, by virtue of their PACKAGE properties. Thus, you can go straight into PCB design by selecting the Netlist to ARES command from the Tools menu in ISIS.

For a fuller discussion of preparing schematics for PCB design, see the chapter entitled ISIS & ARES in the ISIS reference manual (Help Menu in ISIS – ISIS Help command).

Placing the Components

The sample file PPSU.LYT is actually ready placed so the first thing you need to do is remove the components from it. To do this, drag a tag-box round the components (i.e. just outside the board outline) using the right mouse button and then delete all the objects excepting the board edge, which we can leave in place. To do this, use the selection filter as discussed previously – when you have configured correctly right click inside the tag filter and select Delete from the resulting context menu (or simply hit the delete key on the keyboard).

![The Selection Filter configured to tag everything bar the graphics (board edge).](image)

Once this is done, selecting the Component Icon (with a netlisted design, footprints are denoted as components - specified via the schematic - and not packages picked directly by the user inside ARES) will show all the components in the Object Selector as shown below.
The Object Selector for the PPSU sample design after removing the components from the layout.

Object placement is the same as in the previous exercise though this time you will need to use the Rotation icons to select the orientation for some of the parts. This can be done either before placement (using the Rotation icons), during placement (using the ‘+’ & ‘-’ keys on the numeric keypad) or by tagging an object after placement and selecting the appropriate rotation icons from the resulting context menu.

Rotating the op-amp after placement.

We suggest that you start with the op-amp and then place the small components around it. In a real situation, it is normal practice to sketch out a floor plan on paper before you start though in this case you can use the diagram below as a guide.

As you place components, they disappear from the selector - this gives you a clear indication of how many components remain to be placed. If placed components are deleted they are restored to the selector. Note though that this does not apply if components were placed in Package mode and then annotated - only components specified in a netlist are treated this way.

The PPSU layout with all components placed prior to routing.


**Editing a Placed Component**

There are several things you can do to a placed component:

- Move it wholesale by tagging it and dragging with the mouse over the body or pads but not the labels. Whilst dragging, you can use the mapped rotation keycodes (by default the ‘+’ and ‘-’ keys on the numeric pad) to rotate it.

- Move its labels by tagging the whole object and then dragging the label only.

- Move any of its pads by selecting the Selection Icon, tagging the component and then dragging the pad with the left mouse button.

- Rotate or reflect it by tagging it and then selecting the appropriate context menu option (as illustrated).

- Edit its labels by tagging it and then clicking left over the label itself.

- Change any of its pads by placing new ones over them in Pad mode.

**The Ratsnest**

As you place the components, you will see that green ‘ratsnest lines’ or ‘connections’ appear while the object is being placed. It should be fairly intuitive that the longer the ratsnest lines, the less optimum the components position and this is indeed the case - optimizing component placement is equivalent to minimizing the total connection length. Unfortunately, solving this problem is more an art than a science!

- Remember that you can use keyboard shortcuts to rotate a component whilst you are placing or dragging it (default mappings are the ‘+’ and ‘-’ keys). Combined with the ratsnest display, this gives you a rapid means to optimize the orientation of each part as you place it.

- Also worthy of note is the fact that this time there is no need to annotate the parts - when you place U1 it comes out as a DIL08 and there is nothing else to do.

ARES re-calculates the ratsnest not only as components are placed, but also while they are being dragged. This can mean that ratsnest lines may ‘jump about’ as the component’s pads move between various possible connection points. It should be obvious, that with something like a decoupling capacitor, the nearest power pins to it will depend on the region of the board in which it is located.

- The ratsnest is also dynamic during routing as detailed below - clear indication is provided of the nearest connection that can be made at the point when you start placing the route.

In addition, ARES shows *Force Vectors* for each placed component. These appear as yellow arrows which point to the optimum location for the component. The shorter the force vectors, the better the overall placement. The force vector for a component being dragged is also updated in real time, although its effect on the force vectors of the other components is not shown until it is placed. Once a component is tracked to, its force vector will automatically disappear.

You are now ready to begin routing.

**Manual Routing**

If you want you can start this section fresh by reloading the file PPSU.LYT which represents where you should have got to so far. You will find this file in the "Samples\Tutorials" directory within your Proteus installation.

Select the Trace Icon and click left on pin 4 of the op-amp. At this point several things will happen:

- A prompt message will appear in the status bar at the top of the screen indicating that you are routing part of the ground net.

- The nearest destination pad will highlight and the ratsnest line will change to point at the destination pad.

- The trace selector will automatically display trace style T25. This is associated with the net-strategies feature, but for now simply take it that this has been predefined as the default thickness for power nets. Note that this only occurs if the Auto-Trace Selection option on the Tools menu is on.

- A shadow track will follow the mouse - this shows you where a track segment would be placed and on what layer if you clicked left.

Point at the left hand pin of C1 and click left a second time. ARES will sense that you have completed the route and will replace the connection line with a segment of 25 thou tracking. Click left on U1 pin 4 again, move up one grid square, click left, move over to one square above the lower pin of R2 and then down onto the pin.

24
Routing from U4 Pin 4 to R2 Pin 2

The layer on which you are routing is determined by the Layer Selector which is located by default at the bottom left hand side of the ARES application.

ARES will interactively monitor your route placement and inform you of any placement that violates the design rules for the board. At present we have no violations and you should see this indicated at the bottom right of the screen as shown below:

*Interactive DRC reporting no violations.*

If, for example, you right click on the track just placed (U1, pin 4 to R2, pin 2) and then drag the central section of the track down such that it crosses R1, pin 2 (clearly a violation) you will see that ARES detects the problem as soon as you release the mouse and warns you on the status bar.

*Interactive DRC reporting an error.*

Left clicking once on the error message on the status bar will launch the DRC Viewer which will display the violation, the clearance specified in the design rules and the actual clearance. Double clicking on an entry in the viewer will zoom the board into the location of that violation.

Since the cause of the violation is obvious and intentional in this case simply use the undo command (CTRL+Z by default on your keyboard) to put the board back in a correct state - note that when you do this the DRC checker returns to reporting no violations.

- Design Rules can be set independently on a per strategy basis via the Set Strategies command on the System menu. See the section on Router Strategies below for more information.
- Interactive DRC checking is an extremely powerful aid to routing and, together with custom design rule specification, acts as both an excellent quality assurance tool and a real timesaver.

Having returned the board to it’s previous state continue routing by making the connection for U1 pin 4 to Q2’s emitter. In this case, note that you need not take the route pin to pin – the Advanced Netlist Management features enable ARES to tell which ratsnest line to remove, even if you take the route from Q2’s emitter to the route corner above U1 pin 4.

The next connection to do is the one from U1 pin 2 to R1. Assuming that we want to route this on the top side of the board running above the lower row of U1’s pins, press the space bar or else the middle button of your mouse if it has one. This selects the other layer in the current layer pair - in this case 'Top Copper' (you should see this change in the Layer Selector). Route the connection as before, noting that the trace type selected is now DEFAULT as defined in the SIGNAL strategy. Also note that the trace comes out in red, indicating (with the default colours) that it is on the Top Copper layer. Now complete this net by making the connection to R2.
It is in fact possible to route this board with no vias at all. However, for the purposes of tutorial we shall route the connection from U1 pin 3 to C1 using two vias. Start by selecting 'Bottom Copper', click left on U1 pin 3 and then click left twice at a point just below. Clicking left twice at a point places a via and also swaps the primary and secondary layers. The via will take on a layer range determined by the current strategy's via mode (normal, buried or blind). Having got one via, move across to the point just above the target pin, click left twice and complete the route on the underside of the board.

As a finishing touch you can mitre either a particular route or the entire board for aesthetic purposes, to minimise track length or to avoid solder traps. This command is invoked on a per track basis from the right click context menu of the track and globally from the Edit Menu. More information on mitring can be found in the online reference manual.

Auto Routing

Using the auto-router is extremely simple - after all the whole point is for the computer to do the work. To see it in action, start by re-loading PPSU.LYT and then invoke the Auto-Router command from the Tools menu. The default settings will do for this example board so click on OK, sit back and watch. The status display at the bottom of the screen shows what is happening and how things are going. The yellow route is the one being considered for routing. On modern PCs this board will route so fast you will be very lucky to see the routing process at all!

Mixed Manual and Auto-Routing

Although the above exercise routed the board entirely automatically you can, if you wish, exert a lot more control over the proceedings. Reload PPSU.LYT and then select the Ratsnest Icon. The selector will then display a list of the nets in the design. Select the GND net and click on the selector 'T' toggle as shown below. This tags all the connections in the net.

In this mode you can also:

- Tag connections by clicking right over them.
- Tag a connection by clicking right over it.
- Untag all connections by clicking right over nothing.

Given that the auto-router can be set to route all connections or just either the tagged or untagged connections, this gives you total control if you want to mix manual and auto-routing.

Router Strategies

ARES handles the problem of routing different nets with different trace/via widths and so forth in a very sophisticated and convenient manner. Each net in the design is assigned (either implicitly or explicitly) a named strategy which defines how it is to be routed. In practice this means that a net called 12VRAIL can be assigned the POWER strategy on the schematic but that the details of POWER routing can be left undefined until the PCB begins to take shape. At the same time, the need to allocate all sorts of separate properties to each net in the design is avoided.

For a taste of what is possible, invoke the Set Strategies command from the System menu, select the POWER strategy. The Edit Strategy form allows you to determine how nets assigned to this strategy should be routed.

You will see that there are fields for the trace and via styles, the algorithm to use (i.e. POWER, BUS or SIGNAL), controls for whether diagonals are allowed and whether corners should be optimized (i.e. cut at 45 degrees) - each option on the dialogue form has context sensitive help associated with it for quick reference. Up to 4 pairs are allowed per strategy and each pair can use different layers. If the H and V layers for a pass are the same then single sided routing will be attempted.
You can also set individual design rules for each strategy. This can be useful where some tracks must carry high voltages and need to be more widely spaced than those carrying only low voltage signals.

The Set Strategies dialogue form in ARES with the POWER strategy selected.

For more complex designs you can create and configure your own strategies. You create a strategy by placing a wire label on a wire on the net in ISIS with the syntax `STRAT=<NET_NAME>` (see the ISIS reference manual for more details) – it will then appear in the Set Strategies dialogue in ARES where it can be configured as above. This provides a very powerful way of handling nets that require special consideration on a board.

Further details on all these features can also be found in the online help under the sections on Netlist Management and Autorouting (accessible from the Help Menu in ARES).

Connectivity Rule Checker

This tool establishes which pins are connected to each other (by tracking and vias) and compares this with which pins have been assigned to the same net in the netlist. Launchable from the Tools menu this online report indicating the 'net-groups' within each net is produced and written to a file. Also listed are any components specified in the netlist which have not yet been placed and presented in a pop-up window. If you click on the items in the list, the net or nets affected by the error will be highlighted.

If you design from a netlist in the first place, and especially if you use the auto-router, you are unlikely to make mistakes other than missing connections out. However, a zero errors CRC report does give you extra confidence that your design is correct.
Power Planes

As an example of the sophisticated power plane capabilities, we will create a simple ground plane for the PPSU board. Start as follows:

1. Load the file PPSU.LYT.
2. Route it with the autorouter.
3. Select the Connectivity Highlights Icon.
4. Select the GND=POWER net in the Object Selector.
5. Click the 'T' for tag toggle on the Object Selector.
6. Click the Delete Icon or press the delete button on the keyboard.

This sequence of events routes the board, and then removes the ground tracking placed by the router. Then

7. Select the Power Plane Generator command from the Tools menu.
8. Select the GND net (this may appear as “GND=POWER”).
9. Click OK.

ARES will then generate the ground plane.

The Power Plane functionality in ARES is comprehensive and extremely powerful. While we have only touched on it here this topic is discussed in detail in the top level chapter of the reference manual entitled Power Planes.

Cross Probing

The Proteus Design Suite provides a powerful analysis tool in the form of the Design Explorer – this is discussed in some detail in the ISIS documentation. Of particular significance during layout is the cross-probing functionality which allows you to match up a footprint or net in ARES to it’s associated component/net in ISIS. To see this in action reload the PPSU.LYT from disk and also load the PPSU.DSN file in the ISIS capture package. Next, invoke the autorouter in ARES as detailed previously and then save the layout.

At this stage in a typical project we would have created the schematic (PPSU.DSN), netlisted it through to the layout package and placed/routed the board. From within ISIS, launch the Design Explorer and go to Physical Partslist View.

Next, right click on a component of your choice in the Design Explorer and select the Goto PCB Part command from the resulting dialogue form.
Navigating to a footprint from the component in the Design Explorer

You should see that the part in ARES is both tagged and that the Editing Window has zoomed in around the part in question. This is extremely powerful when analysing your project – particularly if the schematic consists of multiple sheets and/or the layout is densely packed or complex.

If you switch back to the Design Explorer (this is a top level window and can be launched from the Windows™ status bar) and move into Physical Netslist View you can then follow the exact same procedure to tag a net in ARES.

Navigating to a footprint from the component in the Design Explorer

It follows that, having driven the project design from the schematic, you can use the Design Explorer/cross probing both during layout for verification and subsequent to board layout for analysis.

Note that in order for cross probing options to be available within the Design Explorer both the schematic and the layout must be open (and be named identically), have no unsaved changes and that the netlist from the schematic must be current with that currently loaded into the layout package. If any of these conditions is not met, the PCB navigation options within the design explorer will be disabled.

Board Manufacture

Typically, you will be producing Gerber/CADCAM data for a board manufacturer. This is discussed in some detail in the reference manual but is actually fairly straightforward and is actioned from the CADCAM Output command on the Output menu in ARES.

We always recommend that a physical prototype is produced and checked prior to large scale manufacture.